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The Archives

Using Hotlists, History and the Link Tree
In this chapter you will learn:

▼ How to use the Global and Local History, Hotlists, and Link 
Tree pages of the Archives to navigate the World Wide Web. 

▼ How to use, create, and manage Hotlists.

Quarterdeck Mosaic uses an area of its display called the Archives to record 
and display all of the sites you visit over a period of several days (seven days 
by default) as well as the sites you visit within a particular browser window.  
The former is the Global History; the latter, the Local History.  Also available in 
the Archives is the Hotlists page containing your Hotlist folders and the Link 
Tree, a diagram showing the hotlinks associated with a document.  

Each of these features appears as a page within a notebook. You can toggle the 
Archives display on and off by clicking on the Archives button on the Toolbar 
or by selecting Archives from the View menu

Figure 5: Archives Pane with Local History Page Selected
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Displaying, Hiding and Resizing the Archives Pane
You may want to hide the Archives pane to create more space for displaying 
documents. The Archives button on the Toolbar acts as a toggle switch to 
display or hide the Archives pane.

To display or hide the Archives pane:

 ◆ Click the Archives button on the Toolbar.

There may be times when you want to resize the Archives pane so you can 
read the full text of its entries. This will come in handy when you view history 
lists, which contain long entries.

To resize the Archives pane:

1 Move the mouse pointer to the right border of the Archives 
pane.

The mouse cursor changes to a two-headed arrow.

2 Hold down the mouse button and drag the pane’s right border 
to the left or right. When you are satisfied with its position, 
release the mouse button. 

Viewing URLs Listed in the Archives
The easiest way to view a document listed in the Archives is to simply click its 
name.  Quarterdeck Mosaic will retrieve the document and display it in the 
current browser window.  If no windows are open, the document is displayed 
in a new window.  

Global and Local History Pages
To view the History pages:

1 If the Archives pane is not visible on the left side of your 
display, click the Archives button on the Toolbar.

2 In the Archives pane, click the tab labeled Global History.

Alternately, you can drag a URL from the Archives pane to an 
empty area of the Quarterdeck Mosaic desktop.  This action 
opens the document in a new window.
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You will see a list of up to 500 URLs you have visited during the 
past seven days.

.

Figure 6: Local History Listing URLs Visited in Current Browser Window

3 Now click the Local History tab.

Displayed in the Archives pane is a list of the documents you 
have viewed in the current (foreground) browser window.  

If you click another window to bring it to the foreground, the Local History 
page changes to reflect the History of the new current window.  If no browser 
windows are open, the Local History page will be empty.  

If you do not see such a list, you may have changed the 
default setting for History Entries Expire After on the Global 
History page of the Preferences notebook. For information, 
see “Global History Options” on page 87.

If you have trouble reading the items in the history list, you 
may want to resize the Archives pane as described in the 
previous section.

Local 
History List
Quarterdefck Mosaic  ◆  39



                    

Magid  Page 40  Thursday, November 9, 1995  5:44 PM
The Global and Local History lists provide information you can use to create 
Hotlists—collections of sites you might want to revisit in the future. 

The Hotlists Page
The Hotlists page of the Archives is a storage place for all of your Hotlist 
folders—collections of URLs—including a number of preconfigured Hotlists 
included with Quarterdeck Mosaic. The Hotlists page is to URLs and Hotlists 
what the root directory is to your hard drive. Your root directory can contain 
files or directories (groups of files); similarly, the Hotlists page can contain 
single URLs or folders of URLs that you have chosen to group together.

Figure 7: Hotlist Page of the Archives

To display the Hotlist page of the Archives:

 ◆ If the Archives pane is not visible, select Archives from the 
Toolbar or View menu, then click the Hotlist tab.

or

 ◆ Select Hotlists from the Windows menu.

Your Hotlists are now displayed in the Archives pane.
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To expand a Hotlist folder and view its contents within the Archives pane:

 ◆ Click the plus sign (+) that appears before it. 

To close a folder and remove its contents from the display:

 ◆ Click the minus sign (-) that appears before it. 

To view the contents of a Hotlist within a browser window:

 ◆ Click on the name of the Hotlist or on its folder icon.

To create a new Hotlist folder on the Hotlists page or in any of its folders:

1 Click the Hotlists tab of the Archives to display your Hotlist 
folders.

2 In the Archives pane, click the name of the Hotlist folder in 
which you want to add the new item. (If you want to add a top-
level hotlist folder, select the folder called Hotlist.)

The folder’s contents display in a browser window.

3 Right click within the borders of the browser window to display 
the Hotlist’s pop-up menu, then select Current Document,  
New, then Folder.

A new folder named Folder will appear.

4 Hold down the Alt key and click on the folder’s name.

A blank box will appear.

5 Type a name for your folder and press Enter.

The folder displays with its new title.

Personalizing Hotlist Folders and URLs
It can be fun to customize a program by assigning your own icons to objects 
or altering the manner in which items are displayed.  Such flexibility can also 
make a program easier to use, by allowing you to work in the way you feel most 
comfortable.  Quarterdeck Mosaic allows you to personalize your Hotlist 
folders and URLs  in the following ways:

To rename a folder or URL:

1 Hold down the Alt key and click the object’s name.
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2 Type in the new name, then press Enter or click outside the 
name.

You can also rename URLs by using pop-up menus:

1 Right click the name or icon to display its menu.

2 Select Properties.

3 Type in a new name, then click OK.

Quarterdeck Mosaic gives you several ways to view Hotlist folders and URLs 
within browser windows.  (Items are always listed in Tree view within the 
Archives.)

To change the way Hotlists and URLs are displayed in a window:

1 Right click within the open folder to display its pop-up menu.

2 Select Current Document, then the arrangement you prefer:  
Icons, Icons List, Text List, or Tree.

Alternately, you can select View from the Menu bar, then select 
an arrangement.

To assign an icon to a Hotlist folder or URL:

1 Right click the Hotlist folder or URL to display its pop-up 
menu.

2 Select URL Object, then Properties from the menu that 
appears.

The File Properties dialog box displays.

3 Click the Change Icon button.

The Change Icon dialog box displays.
42  ◆  Chapter 3: The Archives



 

Essential Internet

                        

Magid  Page 43  Thursday, November 9, 1995  5:44 PM
Figure 8: Change Icon Dialog Box

4 Select an icon from the collection shown or use the Browse 
button to search your drive for an appropriate icon, then click 
OK.

5 Click OK to save your choice and close the dialog box.

Saving URLs to Hotlists
As you explore the Web you are sure to find many sites you will want to revisit 
in the future.  Quarterdeck Mosaic makes it easy for you to save these URLs in 
just a few simple steps.

To save the URL of a currently displayed document to a Hotlist:

1 Right click within the borders of the document to display the 
document’s pop-up menu.

2 Select Current Document, then Save to Hotlist.

Using this method, the URL is saved to the “current” Hotlist.

You can also save the URL of the currently displayed document using drag 
and drop:

1 Make sure that the Hotlist is visible in the Archives pane.

User-defined icons are only available when objects are viewed 
within browser windows and when they are represented by 
large icons. (Large icons are used when you choose the “As 
Icons” or “Icon List” display method and when browser 
windows are minimized to the Quarterdeck Mosaic desktop.)  
User-defined icons are not visible within the Archives, where 
the default mini-icons are always used.
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2 Drag the document's icon from the upper-right corner of the 
browser window to the Hotlist folder in which you want to 
save the URL.

or

 ◆ Drag the document's icon to the Hotlist button on the Toolbar.

Using the second method, the URL is saved to the “current” Hotlist.

To save the URL of a hypertext link within a document to a Hotlist:

1 Right click the link to display its pop-up menu.

2 Select Hypertext Link, then Save to Hotlist.

You can also save a hypertext link using drag and drop:

1 Make sure that the Hotlist is visible in the Archives pane.

2 Hold down the Control key and drag the link itself to the 
Hotlist.

Using this method, the URL is saved to the “current” Hotlist.

To specify a Current Hotlist:

If the Hotlist is displayed in the current browser window:

1 Select Set as Current from the Hotlist menu on the menu bar.

A confirmation dialog box appears.

2 Click Yes to confirm the change.

If the Hotlist is not displayed in a browser window:

1 Click on the Hotlists tab of the Archives pane to display the 
Hotlists page.

2 Right click on the Hotlist you wish to designate as the 
“current” Hotlist to display its pop-up menu.

3 Select Set as Current.

To save a URL from the Global History to a Hotlist:

1 Click a Hotlist to display its contents in a browser window.

2 Select the Global History page by clicking on its tab.
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3 Drag the URL’s icon to the browser window in which the 
Hotlist is displayed and drop it on an empty area (to add it to 
the collection shown) or on a specific folder to add it to a sub-
folder (a Hotlist within the Hotlist.)  In the latter case, a box 
appears around the folder when the cursor is in the proper 
position to “drop” the URL.

Because the contents of the Local History page change when the current 
document changes, you must follow a slightly different procedure when saving 
a URL from a Local History page to a Hotlist.  

To save a URL from a Local History page to a Hotlist:

 ◆ Display the target Hotlist in the same browser window as the 
URL you wish to save.

or 

1 Display the target Hotlist in a new browser window, with both 
windows less than full screen and overlapping. 

2 Drag the URL from the Local History page of the Archives to 
the browser window containing the Hotlist.

The Link Tree Page
The Link Tree page of the Archives gives you a road map of the hypertext links 
in the current browser window.  Documents are listed in a tree, with the 
current document at the top of the list.  Below are the links contained within 
the current document.  Once you visit a URL, Quarterdeck Mosaic remembers 
all of the links in that document for the length of time specified on the Global 
History page of the Preferences notebook.

Each document is represented by a small paper icon. Also shown is the title of 
the link. If a document is preceded by a plus (+) sign, it contains other links. 
Click on the plus sign to expand the display and view these additional links. 
(When expanded, the plus sign changes to a minus (-) sign. Click on the minus 
sign to contract the display.)

As with URLs listed in the History and Hotlists pages of the Archives, you can 
view any URL on the Link Tree page by clicking on it. You can also save a URL 
to a Hotlist or save a document to disk by dragging and dropping it on the 
appropriate Toolbar button.
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Figure 9: Link Tree Page Of The Archives

Importing and Exporting URLs
If you have been using another Web browser, such as Netscape or NCSA 
Mosaic, you may have an extensive collection of URLs.  Netscape’s 
“Bookmarks” - their equivalent of Hotlists - are simply HTML documents in 
which URLs and their titles are stored, while NCSA Mosaic uses a  proprietary 
format to store favorite URLs.  Quarterdeck Mosaic allows you to easily extract 
this information from an NCSA Mosaic or Netscape Bookmark or any other 
HTML file and store it in a new Hotlist folder.  Newly created Hotlist folders 
are placed in the current Hotlist.

To import URLs from an NCSA Mosaic or Netscape Bookmark or an HTML 
file:

1 Select a destination for your newly created Hotlists by 
designating one of your Hotlists as the “Current Hotlist.”  (The 
procedure for setting a Current Hotlist is described earlier in 
this chapter.)

2 Select Import from the File menu.

An Import dialog box appears.

Link Tree
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3 Specify the file you wish to import (such as BOOKMARK.HTM in 
the case of a Netscape Bookmark), then click OK.

A new Hotlist folder containing the extracted URLs is created 
within your Current Hotlist.  

Initially, the new folder is named after the file that was imported.  For instance, 
if you import the following Bookmark file:

C:\NETSCAPE\BOOKMARK.HTM

the folder will be also be named C:\NETSCAPE\BOOKMARK.HTM.  You can 
change the name of a folder by holding down the Alt key and clicking the name, 
then typing in a new name.  

You can also export the URLs in a Quarterdeck Mosaic Hotlist to an HTML 
document or Quarterdeck Mosaic Hotlist folder.  This allows you to share the 
information contained in your Hotlists with others.

To export the URLs in a Quarterdeck Mosaic Hotlist:

1 Display the Hotlist you wish to export in the current browser 
window.

2 Select Save As from the File menu.

The Export dialog box appears.

3 Select the type of file you wish to create (either an HTML file or 
a Quarterdeck Mosaic folder),  specify a name and directory for 
the new file, then click OK.

Quarterdeck Mosaic will create a file with the URLs contained in the Hotlist. 
Note that only the URLs that make up the top level of the Hotlist are exported. 
If the Hotlist contains other Hotlist folders, you must repeat the steps above to 
export those URLs also.
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